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1 Product Features 

1.1 Product Overview 

XB6 series Slice I/O modules adopt the structure of coupler and I/O module combination. The coupler connects 

the expandable I/O modules to the real-time industrial Ethernet system, and the I/O module communication 

backplane adopts X-bus, which provides high real-time performance and a wide range of modules, providing 

users with high-speed data acquisition, optimized system configuration, simplified on-site wiring, and improved 

system reliability. 

1.2 Product Features 

 Less nodes occupied 

A node consists of a bus coupler, 1 to 32 I/O modules of the X-bus series and an end cap. 

 Flexible configuration 

Various types of slice I/O modules are available in any combination. 

 Extensive functionality 

Support flexible expansion, I/O all kinds of complete; can be integrated with digital, analog, temperature and 

other modules, a rich variety, can be applied to different applications needs. 

 High compatibility 

The coupler communication interface conforms to industrial Ethernet communication standards and supports 

mainstream EtherNet/IP masters. 

 Support for parameter configuration 

Supports parameter configuration with automatic saving. 

 High Speed 

The backplane utilizes the X-bus: scanning period max. 1 ms. 

 Easy diagnosis 

Innovative channel indicator design, close to the channel, channel status at a glance, easy to detect and 

maintain. 
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1.3 Application Configuration 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Application method： 

Different modules can be combined, including power supply, coupler, digital, analog, relay, temperature, 

and other modules. 

Application configuration： 

Different I/O module combinations can be adopted depending on master station access capacity, number 

of stations, I/O points, function type, and other requirements. 

Configuration rules： 

From left to right, the modules should be arranged in the order of power supply, coupler module, I/O modules, 

and cover plate (must be configured). 

End cover 
Coupler module 

Extension 

power module 

I/O modules 

Function modules 

I/O modules 

Function modules 



XB6 Series EtherNet/IP Slice I/O User Manual  2 Naming Rules 

 

7                                Copyright © Nanjing Solidot Electronic Technology Co. 

2 Naming Rules 

2.1 Naming Rules 

2.1.1 Coupler Naming Rules 

 

Item Value Description Of The Values 

(1) Bus Type XB: X-bus 

(2) Product Series 6: Slice I/O 

(3) Bus Protocol 

EI: EtherNet/IP 
EC: EtherCAT 
PN: PROFINET 
CB: CC-Link IE Field Basic 
CT: CC Link IE TSN 

(4) Power Supply  20:2A 

(5) Number of Bus Interfaces 02：2*RJ45 

(6) Module Type ST：Kit of power supply, coupler, and cover plate 
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2.1.2 I/O Module Naming Rules 

 

Item Value Description Of The Values 

(1) Bus Type XB: X-Bus 

(2) Product Series 6: Slice 

(3) I/O Module Type 
A：Analog 

Blank：Digital 

(4) Number Of Inputs 
Analog: 0, 4, 8 
Digital: 0, 16, 32 

(5) Number Of Outputs 
Analog: 0, 4, 8 
Digital: 0, 16, 32 

(6) I/O Characteristics 

Digital Analog 

Code Input Output Code Description 

A NPN NPN, 0.5A V -10~+10 V, 0~+10 V 

B PNP PNP, 0.5A I 4~20 mA, 0~20 mA 

BW PNP PNP, 0.25A TM 
Resistance Temperature Detector 
(RTD), thermocouple (TC) 

N NPN/PNP - 

 AN - NPN, 0.1A 

BN - PNP, 0.1A 
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2.2 List of Common Modules 

Model Product Description 

XB6-EI2002ST EtherNet/IP coupler kit (power supply + coupler + cover plate) 

XB6-P2000 Extension power module 

XB6-3200A 32-channel digital input module, NPN type 

XB6-3200B 32-channel digital input module, PNP type 

XB6-0032A 32-channel digital output module, NPN type 

XB6-0032B 
32-channel digital output module, PNP type 

XB6-0032BW 

XB6-1600A 16-channel digital input module, NPN type 

XB6-1600B 16-channel digital input module, PNP type 

XB6-0016A 16-channel digital output module, NPN type 

XB6-0016B 
16-channel digital output module, PNP type 

XB6-0016BW 

XB6-0800A 8-channel digital input module, NPN type 

XB6-0800B 8-channel digital input module, PNP type 

XB6-0008A 8-channel digital output module, NPN type 

XB6-0008B 
8-channel digital output module, PNP type 

XB6-0008BW 

XB6-1616A 16-channel digital input/output module, NPN type 

XB6-1616B 
16-channel digital input/output module, PNP type 

XB6-1616BW 

XB6-3200N 32-channel digital input, NPN/PNP compatible 

XB6-0032AN 32-channel digital output, NPN type 

XB6-0032BN 32-channel digital output, PNP type 

XB6-A80V 8-channel analog input module   

Optional ranges: 0~+10 V, -10~+10 V  
XB6-A40V 4-channel analog input module  

XB6-A08V 8-channel analog output module   

XB6-A04V 4-channel analog output module   

XB6-A80I 8-channel analog input module    

Optional ranges: 0~20 mA, 4~20 mA   XB6-A40I 4-channel analog input module    

XB6-A08I 8-channel analog output module    



XB6 Series EtherNet/IP Slice I/O User Manual  2 Naming Rules 

 

10                                Copyright © Nanjing Solidot Electronic Technology Co. 

XB6-A04I 4-channel analog output module   

XB6-0012J 12-channel relay output module 

XB6-A40TM 4-channel RTD and thermocouple temperature acquisition module 

XB6-A80TM 8-channel RTD and thermocouple temperature acquisition module 

XB6-P04A Pulse output module 

XB6-P20D Encoder counting module 

XB6-P20DS Encoder counting module 

XB6-C01SP Serial communication module 

XB6-VT16 Silce valve terminal 

XX6-C18_2 Common terminal extended module 
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3 Product Parameters 

3.1 General Parameters  

General Technical Parameters 

Size 

Power Module 106X61X22.5 Mm 

Coupler Module 106X61X22.5 Mm 

I/O Modules 106X73X25.7 Mm 

Weight 

Power Module 110g 

Coupler Module 80 g 

I/O Modules 90 g 

Operating Temperature -10℃~+60℃ 

Storage Temperature -20℃~+75℃ 

Relative Humidity 95%, Non-Condensing 

Protection Class IP20 

3.2 Power Supply Parameters 

Power Supply Parameters 

Power Module 

Operating Power 24 VDC（18V~30V） 

Output Voltage 5 VDC 

Output Current 2A, 4A 

Coupler Module 
Operating Power 5 VDC 

Operating Current 400 mA 

I/O Modules Operating Power 5 VDC 
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3.3 Interface Parameter 

Ethernet/Ip Interface Parameters 

Bus Protocol EtherNet/IP 

Number of I/O Stations Depends on the controller 

Data Transmission Medium Ethernet CAT5 cable 

Transmission Distance ≤100 m (station to station) 

Transmission Rate 100 Mbps 

Bus Interface 2XRJ45 

3.4 Digital Parameter  

Signal Type 

Input 

Rated Voltage 24 VDC（18V~30V） 

Number of Inputs 8, 16, 32 

Signal Type  NPN/ PNP 

"0" Signal Voltage (PNP) -3~+3 V 

"1" Signal Voltage (PNP) 15~30 V 

"0" Signal Voltage (NPN) 15~30 V 

"1" Signal Voltage (NPN) -3~+3 V 

Input Filter 3 ms 

Input Current 4 mA 

Isolation Method Optocoupler Isolation 

Electrical Isolation 500 VAC 

Channel Indicator Lights Green LED  

Output 

Rated Voltage 24 VDC (±25%) 

Number of Outputs 8, 16, 32 

Signal Type NPN/ PNP 

Load Type Resistive loads, inductive loads 

Single Channel Rated Current 
NPN type Max: 500 mA  
PNP type Max: 500 mA 
BW type Max: 250 mA 

Port Protection Over-voltage and over-current protection 

Isolation Method Optocoupler Isolation 

Electrical Isolation 500 VAC 
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Channel Indicator Lights Green LED  

relay output 

Rated Voltage 24 VDC（18V~30V） 

Number of Outputs 12 

Isolation Method Optocouplers, Relays 

Rated Load 2 A 

Channel Indicator Lights Green LED light 

 

3.5 Analog Parameter 

3.5.1 Technical Parameters 

Model Type 

Analog Input 

Number of Inputs 4, 8 

Input Signal (Voltage Type) 0~+10 V, -10 V~+10 V (range adjustable)  

Input Signal (Current Type) 0~20 mA, 4~20 mA (range adjustable) 

Resolution  16 bit 

Sampling Rate 
XB6-A40V 、 XB6-A80V 、

XB6-A40I、XB6-A80I 
≤1 ksps 

Accurate 
XB6-A40V、XB6-A80V、 

XB6-A40I、XB6-A80I 
±0.1% 

Input Impedance (Voltage Type) ≥2 kΩ 

Input Impedance (Current Type) 100 Ω 

Electrical Isolation 500 VAC 

Channel Indicator Green LED 

Temperature 
Input 

Number of Inputs 4, 8 

Sensor Type Thermocouple Thermal Resistor Resistor 

Connection Method 2-wire 2-wire, 3-wire 2-wire 

 

K: -200~1370℃ 

J: -200~1200℃ 

E: -200~1000℃ 

S: -50~1690℃ 

B： 50~1800℃ 

Pt100: -200~850°C 

Pt200: -200~600℃ 

Pt500: -200~600℃ 

Pt1000: -200~600°C 

15Ω~3kΩ 
 
 

Accurate ± 0.3% ±1°C ±0.1% 

Sensitivity 0.1°C ±0.1 Ω 

Resolution  16 bit  

Channel Indicator Green LED 
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Analog Output 

Number of Outputs 4, 8 

Output Signal (Voltage Type) 0~+10 V, -10~+10 V (range adjustable) 

Output Signal (Current Type) 0~20 mA, 4~20 mA (range adjustable) 

Resolution  16 bit 

Accurate 
XB6-A04V、XB6-A08V、 

XB6-A04I、XB6-A08I 
±0.1% 

Load Impedance (Voltage Type) ≥2 kΩ 

Load Impedance (Current Type) ≤200 Ω 

Electrical Isolation 500 VAC 

Channel Indicator  Green LED  

Note: The analog voltage module does not support overflow and overshoot, and the analog current module 

supports overflow and overshoot. 

 

3.5.2 Voltage I/O Range Selection and Code Value Table 

Voltage I/O Range Selection and Code Value Table 

Range Selection 0 1 2 3 

Range -10 V~+10 V 0~+10 V -10 V~+10 V 0~+10 V 

Code Value Range -32768~32767 0~32767 -27648~27648 0~27648 

Voltage Input Formula D=(65535/20)*U D=(32767/10)*U D=(55296/20)*U D=(27648/10)*U 

Voltage Output Formula U=(D*20)/65535 U=(D*10)/32767 U=(D*20)/55296 U=(D*10)/27648 

Code Value Table 
See also 
 
Tables3-1 Voltage Code Values . 

Note: D: Code value; I: current 

 

Tables3-1 Voltage Code Values 

Range  

Voltage 

0 (default) 1 2 3 

code value code value code value code value 

-10 -32768    -27648    

-9 -29491    -24883    

-8 -26214    -22118    

-7 -22937    -19354    

-6 -19661    -16589    

-5 -16384    -13824    

-4 -13107    -11059    

-3 -9830    -8294    

-2 -6554    -5530    

-1 -3277    -2765    

0 0  0  0  0  
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1 3277  3277  2765  2765  

2 6554  6553  5530  5530  

3 9830  9830  8294  8294  

4 13107  13107  11059  11059  

5 16384  16384  13824  13824  

6 19661  19660  16589  16589  

7 22937  22937  19354  19354  

8 26214  26214  22118  22118  

9 29491  29490  24883  24883  

10 32767  32767  27648  27648  

  D= (65535/20) *U D= (32767/10) *U D= (55296/20) *U D= (27648/10) *U 

  U=(D*20)/65535 U= (D*10)/32767 U=(D*20)/55296 U= (D*10)/27648 

Note: In the analog voltage input module, when the channel input voltage exceeds 10V, the maximum code value is 

displayed. Analog voltage output module, when the code value setting exceeds the maximum code value 

corresponding to the range in the table, all channels output 10V. 

 

 

3.5.3 Current I/O Range Selection and Code Value Table 

Analog Current Input/Output Range Selection and Code Value Range 

Range Selection 0 1 2 3 

Range 4~20 mA 0~20 mA 4~20 mA 0~20 mA 

Code Value Range 0~65535 0~27648 

Current Input Formula 
D=65535/16*I-
16384 

D=(65535/20)*I D=(27648/16)*I-6912 D=(27648/20)*I 

Current Output Formula 
I=(D+16384)*1
6/65535 

I=(D*20)/65535 
I=((D+6912)*16)/276
48 

I=(D*20)/27648 

Code Value Table See alsoTables3-2 Current Code Values  

Note: D: Code value; I: current 
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Tables3-2 Current Code Values 

Range  

 

Current 

0 (default) 1 2 3 

4-20mA 0-20mA 4-20mA 0-20mA 

code value 

 

code value code value 

 

code value 

0   0    0  

1   3277    1382  

2   6554    2765  

3   9830    4147  

4 0  13107  0  5530  

5 4096  16384  1728  6912  

6 8192  19661  3456  8294  

7 12288  22937  5184  9677  

8 16384  26214  6912  11059  

9 20479  29491  8640  12442  

10 24575  32768  10368  13824  

11 28671  36044  12096  15206  

12 32767  39321  13824  16589  

13 36863  42598  15552  17971  

14 40959  45875  17280  19354  

15 45055  49151  19008  20736  

16 49151  52428  20736  22118  

17 53247  55705  22464  23501  

18 57343  58982  24192  24883  

19 61439  62258  25920  26266  

20 65535  65535  27648  27648  

21 

65535  65535  

29376  29030  

22 31104  30413  

22.814 32511  31538  

22.962 

32767  

 

 

 

31743  

23 31795  

23.518 32511  

23.703 

32767  24 

25 

 D=65535/16*I-16384 D = (65535/20)*I D=(27648/16)*I-6912 D=(27648/20)*I 

Note: When the input current of range 2 is > 22.81 mA, the code values all show 32767; when the specified code 

value is > 32511, the output current is 22.81 mA. 

For range 3 input current > 23.52 mA, the code values all show 32767; for specified code values > 32511, the 

output current is 23.52 mA. 
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3.6 Common Terminal Expansion Module Parameters 

Common Terminal 

Rated Voltage 125 VDC/AC 250V 

Rated Current 8 A 

Number of Common Terminals 2 sets 
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4 Panel 

4.1 Coupler Panel 

4.1.1 Coupler Structure 

 

Number Name Description 

① Power interface Push-in terminal blocks 

② Guide rail slot Suitable for DIN 35 mm rail fixing 

③ Power ID, indicator Indicates power status 

④ Rotary switches and ID IP address and reset settings 

⑤ System ID, indicator Indicates power supply, module operation status 

⑥ Bus interface 2×RJ45 

 

Name and function description of each part of the product 
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4.1.2 Rotary Switch  

IP address setting  

A rotary switch can be used to specify the setting method of the module IP address. 

 

 

Set value (decimal) IP address setting method 

000 BOOTP-based settings 
The factory rotary switch is set to "000", the default state is based on the BOOTP 
setting, if it has been modified using the host computer, continue the last setting 
value to start. 

001 to 254 Sets the IP address lower 1Byte in the range of 1 to 254 by "×100" for the hundredth 
digit, "×10" for the tenth digit, and "×1" for the first digit. Setting in the range of 1 to 
254 by "×100" for the hundreds digit, "×10" for the tens digit, and "×1" for the bits. 
IP Address High 3Byte Continuation of the value last set via the host computer. 
When the IP address is set to a value other than 000 by the rotary switch in the 
factory factory state, the high 3Byte is 192.168.0. 

255~ When the rotary switch is set to 255 or above, the module starts with the previous 
startup method and parameters after powering up. 

Precautions  

1、 Tool selection 

Screwdriver size: 3 mm opening 

2、 Be sure to set the rotary switch IP with the power off. 

3、 If the IP address needs to be changed during communication, the new settings must be re-powered to take 

effect after the new settings are completed. 

Reset Function   

Restoration of factory settings can be executed by special operation of the rotary switch. 

For more information on how to do this, see7.3Restore Factory Settings  
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4.1.3 ID and Indicators 

Description of IDs and indicators of the power module 

ID Color Status Status description 

P Green 

ON Normal status of working power supply 

Flashing 80% overload. The power supply to real stage load is cut off 

OFF Unpowered or abnormal power supply 

O Red 

OFF No overload 

ON 90% overload 

Flashing 80% overload. The power supply to real stage load is cut off 

 

 

Description of IDs and indicators of the coupler module 

ID Color Status Status description 

P (PWR) GREEN 
ON Normal status of power supply 

OFF Unpowered or abnormal power supply 

L (LINK) GREEN  

ON The I/O module is connected, X-bus system is interacted 

Flashing 1Hz The I/O module is connected, X-bus system is ready to interact  

Flashing 5Hz 
The I/O module is not connected, X-bus system configuration 
abnormal 

OFF The I/O module is not connected or abnormal connection 

E (ERR) RED 

ON 
An unrecoverable major error has occurred on the device 
(constant illumination is not supported for devices with S/N 
numbers beginning with 1294) 

Flashing 1Hz 

Equipment being tested for power-up 
A recoverable secondary exception occurred on the device 
(devices with S/N numbers beginning with 1294 blink to represent 
an IP conflict) 

OFF Equipment in working order 

N (NS) GREEN 

ON The device has established a connection 

Flashing 1Hz 
Device has not established a connection, but IP address is 
acquired; device is undergoing a power-up test 

OFF 
Device did not obtain an IP address; duplicate IP address or 
power cutoff 

 

Network port status indicator 

ID Color Status Status description 

IN 

Green 
ON establish a network connection 

OFF No network connection established or abnormal 

Yellow 
Flashing Connection established with data interaction 

OFF No data interaction or exception 
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OUT 

Green 
ON establish a network connection 

OFF No network connection established or abnormal 

Yellow 
Flashing Connection established with data interaction 

OFF No data interaction or exception 

4.2 I/O Module Panel 

Names and functional descriptions of each part of the module 

 

  

Table 4-1 Indicator Description 

Port Status Indicator 

ID Color Status Status description 

P Green 

ON Power supply normal 

OFF 
The product is not powered up or the power supply is 
abnormal 

R Green 

ON The system is functioning normally 

Flashing 1 Hz I/O modules connected, X-bus system ready for interaction 

OFF 
Device is not powered up, X-bus is not interacting with data 
or is abnormal 

Input Channel 
Indication 

Green 
ON  Module detects channels with signal inputs 

OFF No signal input or abnormal signal input on module channel 

Output Channel 
Indication 

Green 

ON Module channels have signal outputs 

OFF 
No signal output or abnormal signal output from module 
channel 
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5 Installation and Disassembly 

5.1 Installation Guide 

Module Installation Precautions 

 Ensure that the cabinet is well ventilated. 

 Do not install this unit next to or above equipment that may generate excessive heat. 

 Be sure to install the module in a vertical position and maintain air circulation around the module (at least 

50 mm air space above and below the module). 

 After the module is installed, be sure to secure the module by installing rail mounts on both ends of the 

module. 

 Be sure to disconnect the power supply when installing/disassembling. 

Minimum clearance for module mounting (≥50 mm) 

 

 

Ensure that the module is mounted vertically   
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Be sure to install the rail mounts       

 

 

 

 

 

 

 

 

 

5.2 Installation And Disassembly Steps 

Module Installation and Removal 

Module Installation 
Steps 

1. Install the power supply module first on the rail that has been fixed. 
2. Install the coupler and the required I/O modules in turn to the right of the power 
supply module. 
3. After installing all required I/O modules, install the end caps to complete the 
module assembly. 
4. Install the rail fixings on both ends of the power module and end cap to fix the 
module. 

Module disassembly 
procedure 

1. Loosen the rail fixings at both ends of the module. 
2. Use a one screwdriver to pry off the module snap. 
3. Pull out the disassembled module. 

 

5.3 Installation Diagram 

Power module installation  Steps 

 

 

 

 

Align the power module 

guide rail slot vertically 

with the guide rail, as 

shown in the figure① 

 

 

 

           ① 
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Press the power 

module with force until 

a "click" sound is heard. 

The module is now 

installed in place, as 

shown in the figure②. 

 

 

 

② 

 

Coupler module installation  Steps 

 

 

Align the left slot of the 

coupler module with the 

right side of the power 

module, and push it in 

as shown in the figure

③. Press the module 

with force into the guide 

rail until a "click" sound 

is heard. The module is 

now installed in placed. 

③ 

I/O module installation  Steps 

 

 

 

Install the required IO 

modules one by one 

using the same the 

steps as coupler 

module installation, as 

shown in the figure④⑤ 

 

 

 

                                 

④ 
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⑤ 

 

End cover installation  Steps 

 

 

Install the end cover on 

the right side of the last 

module, as shown in 

the figure⑥, using the 

same installation 

method as the coupler 

module. 

 

 

 

                                  ⑥ 

Installation of guide rail fasteners  Steps 

  

 

 

Install a guide rail 

fastener next to the left 

side of the coupler, and 

lock it tightly, as shown 

in the figure⑦ 

 

 

 

 

 

⑦ 



XB6 Series EtherNet/IP Slice I/O User Manual                                         5 Installation and Disassembly 

 

26                                Copyright © Nanjing Solidot Electronic Technology Co. 

Install a guide rail 

fastener on the right 

side of the end cover. In 

this process, first push 

the guide rail fastener 

towards the coupler to 

ensure that the module 

is installed firmly, and 

then lock the fastener 

with a screwdriver, as 

shown in the figure⑧ 

 

                                 ⑧ 

 

Disassembly  Steps 

  

Using a screwdriver, 

loosen the guide rail 

fastener at one end of 

the module, and move it 

to one side to create a 

gap between the 

module and the 

fastener, as shown in 

the figure⑨ 

 

⑨ 

 

Insert the slotted 

screwdriver into the 

snap fitting of the 

module to be removed, 

and exert force along 

lateral direction of the 

module (until a click 

sound is heard), as 

shown in the figure⑩. 

Note: Each module 

has two snap fittings, 

one on the top and 

the other at the 

bottom. Both should 
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be operated in this 

way. 

⑩ 

                                                                      

 

 

 

 

Remove the module in 

the reverse order of 

installation, as shown in 

the figure⑪. 

 

 

 

 

 

⑪ 
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5.4 Dimensions 

Power module dimensions (Unit: mm) 

 

 

 

Coupler module dimensions (Unit: mm) 
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Extension power module dimensions (Unit: mm) 

 

 

I/O module dimensions (Unit: mm) 
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End cover module dimensions (Unit: mm) 

 

Note: All installed with DIN 35 mm standard guide rail, specification 35*7.5*1.0 (unit mm) 
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6 Wiring 

6.1 Wiring Terminal 

Wiring Terminal 

Signal Wire Terminal 

Number of Poles 16 P 

Number of Poles 20 P 

Wire Gauge 26 -16 AWG 0.3-1.0 mm² 

Power Terminal 
Number of Poles 3P 

Wire Gauge 26 -12 AWG 0.3-1.5mm² 

Bus Interface 2*RJ45 Category 5+ UTP or STP (STP recommended) 
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6.2 Wiring Instructions and Requirements 

Power supply wiring precautions 

 

 
 The module system-side power supply and field-side power 

supply need to be configured separately, do not mix them. 
 PE needs to be reliably grounded. 

 

Tables 6-1 Tooling and Wiring Requirements 

Wiring Tool Requirements 

The terminal adopts screwless design, and the 
installation and removal of cables can be 
operated by using a screwdriver (specification: 
≤3 mm). 

 
Stripped Wire Length Requirements 

Recommended stripping length 10 mm 

 
Wiring Method 

For single stranded hard wires, after stripping the 
corresponding length of wire, press down the 
button while inserting the single stranded wire. 

 
Multi-stranded flexible wires, after stripping the 
corresponding length of wire, can be directly 
connected or supporting the use of the 
corresponding standard specifications of the cold 
compression end (tube-type insulated terminals, 
as follows), press down the button at the same 
time the line will be inserted. 

 

 

Tube Insulation End Specification Sheet 

specification model number Cross-sectional 
area of conductor 
mm² 

 
Tube insulated terminal L ≥ 10 mm in length 

E0510 0.5 

E0310 0.3 

E7510 
0.75 

E7512 

E1010 
1.0 

E1012 

E1510 
1.5 

Tube insulated terminal L ≥ 10 mm in length E1518 

 

Power supply wiring: power module 3P terminal 
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Using the DC24V power module, refer to the wiring method and connect the power supply according to the circuit 

shown in the following figure, and at the same time ground PE reliably (twisted-pair wire is recommended for the 

power supply cable). 

Figure 6-1 Coupler, I/O Module, and Power Supply Wiring Diagrams 

 

 

Figure 6-2 Coupler, I/O Module, Power Module, I/O Module, Power Supply Wiring Diagrams 

 

        

 

 

  



XB6 Series EtherNet/IP Slice I/O User Manual                                                              6 Wiring 

 

34                                Copyright © Nanjing Solidot Electronic Technology Co. 

Load power wiring: 20P terminal on field side 

Refer to the corresponding I/O module wiring diagram and wiring method to press the signal wire cable into 
the terminal block. 
The load power supply uses 24 VDC power supply, refer to the wiring method and connect the power supply 

according to the circuit shown in the left figure (refer to the corresponding).1.1 错误!表格结果无效。 ). 

 
Signal terminal wiring: 16P\20P terminal  

Refer to the corresponding I/O module wiring diagram and wiring method to press the signal wire cable into the 

terminal block. 

Bus wiring: Industrial Ethernet bus communication interface 

8

1

1

8

 

Pin signal 

1 TD+ 

2 TD- 

3 RD+ 

4 一 

5 一 

6 RD- 

7 一 

8 一 

 

It is recommended to use category 5 or higher double-shielded (braided mesh + aluminum foil) STP cables as 
communication cables, and the wiring method refers to6.3 XB6-EI0002 Communication Interface Wiring . 
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6.3 XB6-EI0002 Communication Interface Wiring 

Some of the XB6-EI0002 coupler screen prints are identified as IN/OUT as shown below. 

When wiring, it is necessary to connect the network topology according to the corresponding scenario examples, 

otherwise communication failures may occur. 
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6.3.1 Scenario 1: There Is Only One Set of XB6-EI0002 Modules in the Network 

When there is only 1 set of XB6-EI0002 modules in the network: 

 The "IN" port of the module is connected to any network port of the previous node device; 

 The "OUT" port of the module is connected to any of the network ports of the device of the following node, 

for example, as shown in the figure below. 

When connecting to devices from other manufacturers, follow the network topology specification of the 

corresponding manufacturer. 
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6.3.2 Scenario 2: There Are Multiple XB6-EI0002 Modules in the Network 

When there are multiple XB6-EI0002 modules in the network: 

 The "IN" port of the first module is connected to any network port of the previous node device; 

 The last module "OUT" port is connected to any network port of the device in the next node; 

 Module to module connection must follow the principle of "IN" to "OUT", such as shown in the following 

figure. 

When connecting to devices from other manufacturers, follow the network topology specification of the 

corresponding manufacturer. 
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6.3.3 Scenario 3: Using Switches In A Network 

When a switch is used in the network: 

 The "IN" port of the module is connected to any network port of the switch; 

 Module to module connection must follow the principle of "IN" to "OUT", such as shown in the following 

figure. 

When connecting to devices from other manufacturers, follow the network topology specification of the 

corresponding manufacturer. 
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6.4 I/O Module Wiring Diagram 

XB6-3200N, XB6-0032AN, XB60032BN wiring diagrams refer to the XB6 Series_MIL Connector Type IO User's 

Manual. 

6.4.1 XB6-3200A 

 
  

*24V internal conduction; 0V internal conduction 
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6.4.2  XB6-3200B 

 

  

*24V internal conduction; 0V internal conduction 
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6.4.3  XB6-1616A 

 

  

*24V internal conduction; 0V internal conduction 
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6.4.4  XB6-1616B 

 

  

*24V internal conduction; 0V internal conduction 
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6.4.5  XB6-1600A 

 

  

*24V internal conduction; 0V internal conduction 
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6.4.6  XB6-1600B 

 

  

*24V internal conduction; 0V internal conduction 
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6.4.7  XB6-0800A 

 

  

*24V internal conduction; 0V internal conduction 
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6.4.8  XB6-0800B 

 

  

*24V internal conduction; 0V internal conduction 
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6.4.9  XB6-0032A 

 

  

*24V internal conduction; 0V internal conduction 

*Load common terminal power supply need to be the same as modules 
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6.4.10  XB6-0032B 

 

  

*24V internal conduction; 0V internal conduction 

*Load common terminal power supply need to be the same as modules 
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6.4.11  XB6-0016A 

 

  

*24V internal conduction; 0V internal conduction 

*Load common terminal power supply need to be the same as modules 
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6.4.12  XB6-0016B 

 

  

*24V internal conduction; 0V internal conduction 

*Load common terminal power supply need to be the same as modules 
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6.4.13  XB6-0008A 

 

  

*24V internal conduction; 0V internal conduction 

*Load common terminal power supply need to be the same as modules 
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6.4.14  XB6-0008B 

 

  

*24V internal conduction; 0V internal conduction 

*Load common terminal power supply need to be the same as modules 
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6.4.15  XB6-0012J 

 

  

*24V internal conduction; 0V internal conduction 

*Load common terminal power supply need to be the same as modules 

*COM can be connected to positive or negative electrodes, it’s not 

connected inside and support DC0-48V 
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6.4.16  XB6-A80V 

 

  

*COM internal conduction 

*All channel loads need to use the same power supply  



XB6 Series EtherNet/IP Slice I/O User Manual                                                              6 Wiring 

 

55                                Copyright © Nanjing Solidot Electronic Technology Co. 

6.4.17  XB6-A80I 

 

  

*COM internal conduction 

*All channel loads need to use the same power supply  
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6.4.18  XB6-A40V 

 

  

*COM internal conduction 

*All channel loads need to use the same power supply  
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6.4.19  XB6-A40I 

 

  

*COM internal conduction 

*All channel loads need to use the same power supply  
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6.4.20  XB6-A08V 

 

  

*COM internal conduction 

*24V internal conduction; 0V internal conduction 
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6.4.21  XB6-A08I 

 

  

*COM internal conduction 

*24V internal conduction; 0V internal conduction 
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6.4.22  XB6-A04V 

 

  

*COM internal conduction 

*24V internal conduction; 0V internal conduction 
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6.4.23  XB6-A04I 

 

  

*COM internal conduction 

*24V internal conduction; 0V internal conduction 
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6.4.24  XB6-A80TM 

 

  

 
*PE internal conduction 

*2-wire thermal resistor needs to short-circuit "-" and "C" externally 

*4-wire sensors need to be changed to 2-wire or 3-wire access 
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6.4.25  XB6-A40TM 

 

  

 *PE internal conduction 

*2-wire thermal resistor needs to short-circuit "-" and "C" externally 

*4-wire sensors need to be changed to 2-wire or 3-wire access 



XB6 Series EtherNet/IP Slice I/O User Manual                                                              6 Wiring 

 

64                                Copyright © Nanjing Solidot Electronic Technology Co. 

6.4.26 XB6-P04A 
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6.4.27 XB6-P20D 

 

 

 

 
*24V internal conduction; 0V internal conduction 

*CI is the common terminal of input channels I0~I3, internally conductive, NPN/PNP compatible 

*The load common terminal power supply should use the same power supply as the module 
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6.4.28 XB6-P20DS 

 

 

*24V internal conduction; 0V internal conduction 

*CI is the common terminal of input channels I0~I3, internally conductive, NPN/PNP compatible 

*The load common terminal power supply should use the same power supply as the module 
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6.4.29 XB6-C01SP 

 

  

 

*GND is the RS232 signal ground, internally conductive 

*Cables should use shielded twisted pairs and be reliably grounded  
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6.5 Common Terminal Expansion Module Wiring Diagram 

 

 

 

*C0 Line 1 internal conduction; C1 Line 1 internal conduction;  
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7 Operation 

7.1 Modular Application 

Two combinations are available for the product as shown below, each containing a coupler, I/O modules and an 

end cover. 

First product combination (coupler, I/O modules, cover plate) 

   Coupler              I/O modules                       Cover plate 
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Coupler             I/O modules    extension power module   I/O modules      cover plate 

Limitations on the number of module configurations： 

1. The number of IO modules that can be supported by a coupler is not higher than 32. 

2. The number of analog modules should not exceed 12, and the number of 8-channel analog inputs should 

not exceed 8. 

3. If the number of I/O modules configured in the system exceeds 10, additional expansion power modules are 

required, and the number of I/O modules configured after the expansion power modules ≤ 12. 

 

7.2 IP Settings And Modifications 

7.2.1 Setting The IP Address With A Rotary Switch  

The description and operation of the rotary switch is detailed in "4.1.2Rotary Switch " 

 When the IP address is set by rotary switch from the factory status 

IP address is 192.168.0.XXX (XXX is the setting value of the rotary switch, range 1~254). 

 When setting the IP address with the rotary switch from a state where the IP address has already 

been set with the host computer 

The IP address follows the high 3byte of the IP address set via the host computer and the low 1byte is the 

setting value of the rotary switch. 

For example, if you change the setting of the rotary switch after setting it to 172.10.0.12 from the host 

computer, the rotary switch setting will be changed to 172.10.0.12. 

The IP address is 172.10.0.XXX (XXX) for the rotary switch setting (1 to 254). 

Second product combination (coupler, I/O modules, extension power module, I/O modules, cover plate) 

 
 

  

 Device IPs with S/N numbers beginning with 1259 support Class B addresses, others do 
not. 

 When modifying the IP, the IP Setting Tool tool is recommended for devices with S/N 
number 1294. 

 Devices with S/N numbers starting with 1294 support IP modification in communication. 
Modifying IP while other devices are connected keeps the connection uninterrupted, and 
the IP will not take effect until it is re-powered. 

 Devices cannot be scanned when there is an IP conflict for a device whose S/N number 
begins with 1294. 
1 device can be scanned in case of IP conflict of other S/N number devices. 
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 When the module is shipped from the factory, the rotary switch is set to "000", the IP 
address is not assigned, and the IP address defaults to 192.168.0.120 for devices with 
S/N number beginning with 1294. 

 After the modification by the host computer is completed, the module modifies the startup 
method to fixed IP startup and reboots automatically. The module starts with the rotary 
switch setting value and the IP address composed of the assigned network segment. 

 Abnormal rotary switch setting: When the rotary switch is set to 255 or 255 or more, the 
module starts in the same way as the previous startup with parameters after powering 
up. 
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7.2.2 Setting The IP Address Via The Host Computer Software 

Toggle the rotary switch to 0, power up the module, scan the module using the host computer, and click on 

the IP address field of the module to modify the IP address after scanning the module. 

This section describes how to change the IP address, using the Keens KV-8000 and the upper computer KV 

STUDIO Ver.10G as examples: 

1、 scanning device 

 

2、 IP modification 

Click "IP Address" displayed in the "Device Search Results" to bring up the "IP Address Settings" dialog box. 

Set the IP address. 
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Precautions 

 If you use BOOTP to modify the IP address, you need to set the request acceptance time when scanning 

and the timeout time when setting the IP address to 60s. After the upper computer modification is 

completed, the module modifies the startup method to fixed IP startup and restarts automatically. The 

module starts with the IP address composed of the rotary switch setting value and the assigned network 

segment. 

 If the IP is modified across network segments, after the modification is completed, the host computer may 

not be in the same network segment as the module, resulting in the host computer prompting a timeout or 

not being able to scan to the module after the allocation, which can be solved by modifying the IP address 

of the host computer so that it is in the same network segment as the module. 

7.2.3 Setting An IP Address With The IP Setting Tool 

After the device is powered on, you can set the coupler IP address using the IP Setting Tool. 

1. Open the IP Setting Tool and click the Scan for EtherNet/IP Devices button. 

 

2. Set the IP segment and click OK. 

  

Check the coupler S/N number (appearance available). 
Devices with S/N number starting with 1294 support modifying device IP in communication, 
while devices of other versions do not support modifying device IP in communication for the 
time being. 
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Examples of scanned devices are shown in the following figure. 

 

3. Double-click the device and set the IP address in the pop-up "IP Settings" window, as shown below. 

 

7.2.4 Setting the IP Address Via Ethernet Device Configuration 

After the device is powered on, you can set the coupler IP address through the Ethernet Device 

Configuration tool. 

1. Open the Ethernet Device Configuration tool and click the "Scan for Search Devices" button to search for 

devices as shown below. 

  
Devices with S/N numbers starting with 1294 do not support IP modification by this tool. 
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2. Click "Configure -> Set IP Adress", the window shown below will pop up, set the IP address and subnet 

mask according to the actual situation. 

 

7.3 Restore Factory Settings 

If the IP address is forgotten, lost or other abnormalities occur during use, the module can be reset through the 

IP address reset function. 

Restore factory settings operation by rotary switch as follows: 

1. Power up the module by flipping the rotary switch to 999. 

2. After the module is powered up, flip the rotary switch back to 000 without disconnecting power. 

3. After the rotary switch is flipped back to 000, the module automatically performs a restoration of the factory 

settings. 

4. After the module is restored to factory settings, the IP address parameter is cleared and the startup mode is 

BOOTP. 

  

● Devices with S/N numbers beginning with 1294 have a reset IP address of 
192.168.0.120. 

● Other versions of the device reset with the IP address parameter cleared and the boot 
method BOOTP. 
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7.4 Module Parameter Setting Function 

7.4.1 Digital Output Clear/Hold Function 

The Clear/Hold function is for modules with outputs. This function configures the output action of the module 

when communication is disconnected. 

Clear Output: When communication is disconnected, the module output channel automatically clears the 

output. 

Hold Outputs: The module output channels keep outputs when communication is disconnected. 

Configuration method 

  See "7.6Bus Module Configuration Description ". 

*Repowering is recommended after modifications are completed. 

7.4.2 Module Output Action Configuration Function in Bus RUN/IDLE State 

The RUN/IDLE state output action configuration function is for modules with outputs, and you can select the 

action of the module outputs to be held or cleared when the bus state is switched to the idle state. 

Configuration method 

See "7.6Bus Module Configuration Description ". 

*Repowering is recommended after modifications are completed. 

7.4.3 Digital Input Filter Time 

Digital input filtering prevents the program from responding to unexpected rapid changes in the input signal, 

which may be generated by switch contact jumps or electrical noise. Digital Input Filtering is currently configured 

in a fixed 3ms configuration to filter out noise within 3ms, channels are not individually configurable. 

An input filter time of 3 ms means that a single signal change from "0" to "1" or from "1" to "0 "A single high or 

low pulse shorter than 3 ms will not be detected. 

Configuration method 

See "7.6Bus Module Configuration Description ". 

*Repowering is recommended after modifications are completed. 

7.4.4 Analog Filter Settings Function 

Analog input filter function 

The analog input filter function averages the A/D converted data internally to reduce the effects of fluctuations 

in the input signal due to noise. 

Analog inputs are processed as moving averages with a specified number of A/D conversions. 

Filter Function Configuration 

Each channel can be configured individually, configuration range: 1~200 times, default 10 times; 

8-channel module sampling rate is: 1.25KHZ/8 channels (800us/8 channels); 

4-channel module sampling rate is: 2.5KHZ/4 channels (400us/4 channels). 

Configuration method 

See "7.6Bus Module Configuration Description ". 

*Repowering is recommended after modifications are completed. 
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7.4.5 Analog Range Configuration Function 

The analog range setting function is used to set the analog range (see "3.5Analog Parameter "). 

Configuration method 

See "7.6Bus Module Configuration Description ". 

*Repowering is recommended after modifications are completed. 
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7.5 Process Data 

7.5.1 I/O Module Process Data 

Digital I/O modules. 

Each module is assigned a length of 4Byte data unit, each channel occupies 1Bit, the actual length of data used 

varies depending on the number of module channels. 

Analog I/O modules: 

Each module is assigned a length of 16 Byte data unit, each channel occupies 2 Byte, the actual length of data 

used varies depending on the number of module channels. 

The data lengths are allocated in the table below. 

Module Model 

Uplink process data length (Byte) Downstream process data length 
(Byte) 

assigned value Actual value used assigned value Actual value 
used 

XB6-EI0002 4 4 - - 
XB6-3200A/B 4 4 - - 
XB6-1600A/B 4 2 - - 
XB6-0800A/B 4 1 - - 
XB6-0032A/B - - 4 4 
XB6-0016A/B - - 4 2 
XB6-0008A/B - - 4 1 
XB6-1616A/B 4 2 4 2 
XB6-0012J - - 4 2 
XB6-VT16 - - 4 2 
XB6-A80V 16 16 - - 
XB6-A40V 16 8 - - 
XB6-A80I 16 16 - - 
XB6-A40I 16 8 - - 
XB6-A08V - - 16 16 
XB6-A04V - - 16 8 
XB6-A08I - - 16 16 
XB6-A04I - - 16 8 
XB6-A80TM 16 16 16 16 
XB6-A40TM 16 8 16 8 
XB6-P20D 20 20 16 12 
XB6-P20DS 20 20 2 2 
XB6-P40A 24 24 36 36 
XB6-C01SP 40 40 40 40 
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7.5.2 Coupler Process Data 

The coupler is allocated 4Byte of data for coupler status indication and alarms, definition of bottom bus status 

indication and topology comparison hints. 

Bottom bus status indication: 

status value State Definition account for 

1 Bottom Bus Initialization Bottom bus initialization phase 

2 Bottom Bus Ready 
The bottom bus is pre-connected and only performs parameter 
downstreaming 

4 Bottom bus open status 
Bottom bus opens connection to perform process data 
interaction 

Topology State Comparison Status Tip: 

status value account for 

0 Topology comparison normal 

1 There is a mismatch of I/O module types in the topology 

2 Unconfigured topology 

3 There are I/O modules missing from the topology 

4 Excess I/O modules in the topology 

5 There are I/O module types in the topology that are not supported by the coupler 
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7.6 Bus Module Configuration Description 

7.6.1 Application in CODESYS V3.5 Software Environment 

1. Preparations 

Hardware Environment 

A computer with CODESYS V3.5 software pre-installed. 

Network cables. 

One switching power supply. 

Module mounting rails and rail fixings. 

Please configure the module model and type according to the actual configuration, such as the following 

table: 

Devices Model Number Quantities 

PLC 
CODESYS Control Win V3 - x64 SysTray 
Software 

- 

Coupler XB6-EI0002 1 

I/O Modules 

XB6-3200A 1 

XB6-0032A 4 

XB6-0032B 1 

XB6-A40V 1 

End Cover XB6-CVR00 1 

Device Configuration Files   

Configuration file access: https://www.solidotech.com/documents/configfile  

Hardware configuration and wiring 

Please follow the "5Installation and Disassembly " and "6Wir " require operation. 

2. Installing the device configuration file 

1. Install the EhterNet/IP EDS device description file ("XB6_EI0002_VX.X.EDS"). 

a) Open CODESYS software and select "Tools -> Device Repository". 

b) Click "Install" and select the relevant EDS file to install. 

Successful installation shows that the device "xxxx" has been installed to the device repository, as 

shown in the following figure. 
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3. New construction 

Click "File" and select "New Project". 

 

4. Add "Ethernet" 

1. Start the PLC with "CODESYS Control Win V3 - x64 SysTray". 

2. Double-click "Device (CODESYS Control Win V3 X84)" in the left navigation tree, and then click "Scan 

Network". 

3. Select the device, scan the network, and the network is active, as shown in the figure below: 
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4. Select "Device(CODESYS Control Win V3 X84) " " in the left navigation tree, right click and select "Add 

Device". 

5. Select "EthernetIP -> Ethernet Adapter -> Ethernet" as shown below. 

 

6. Select "Ethernet" in the left navigation tree, right click and select "Add Device". 

7. Select "EthernetIP -> EthernetIP Scanner -> Ethernet/IP Scanner" as shown below. 
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5. Configure "EthernetIP". 

1. Double-click on "Ethernet" in the left navigation tree to open the configuration window. 

2. On the General tab, click  to the right of Interfaces and select Network Adapters, as shown in the 

following figure. 

 

Click "Confirm". 

6. Add Device 

1. Log in to the device. 

2. Check "EtherNet_IP_Scanner (EtherNet/IP Scanner)" in the left navigation tree and click Scan Devices. 

3. Select "XB6_EI0002" and click "Copy to Project" as shown below. 
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The device has been added, as shown below. 

 

7. Parameter setting and I/O module addition 

The parameter setting function is used to configure the configuration of uplink data, downlink data, digital 

clear hold, input filtering, analog range, configuration, and temperature module parameters.Table 7-1 

Parameter Description Parameter Description 

1. Double-click the device to open the "Device Configuration" window, switch to the "Connections" page, as 

shown below. 
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2. To modify the parameter values, see parameter descriptions inTable 7-1 Parameter Description 

Parameter Description 

 

Add the I/O modules in sequence according to the system configuration, such as shown in the following 

figure. 
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Table 7-1 Parameter Description 

Parameters Parameter Description 

T-->O Size (byte) 

Uplink data, equal to 4+n*4+m*16  
n: number of digital input I/O modules (including hybrid I/O 
modules)  
m: number of analog input I/O modules 

O-->T size (byte) 

Downstream data, equal to j*4 + k*16  
j: number of digital output I/O modules (including mixed I/O 
modules)  
k: number of analog output I/O modules 

Hold or Clear Parameter 
The output is cleared or held: 
0: Clear, default is "0". 
1: Hold. 

IDLE Status Output Mode 
Module output action in bus RUN/IDLE state, configured as 
"0", clear, configured as "1", hold, default is "0". 

Digtal Input Filter Config Digital input filtering, default setting is "3 ms". 

Analog Input Filter Config Analog input filter, default setting is "10". 

Analog Voltage Input Range Select Analog input voltage module range, default setting is "0". 

Analog Electricity Input Range Select Analog input current module range, default setting is "0". 

Analog Voltage Output Range Select Analog output voltage module range, default setting is "0". 

Analog Electricity Output Range Select Analog output current module range, default setting is "0". 

Temperature IO Module Sensor Select 
Temperature module parameter that allows you to configure 
the type of sensor. 

Temperature IO Moduler Filter Config Temperature module filter configuration. 

IO Module n 
Configured as I/O in the actual configuration. 
Modify IO Module 1~ IO Module n to the corresponding 
configuration. 

3. Click "Online -> Multiple Downloads" and select "Always perform full downloads". 

4. Click  and the system is online. 

8. Check the device indicator 

XB6-P2000H: P light is always on in green color.  

XB6-EI0002: P light is always on in green color, L light is always on, E light is not on, N light is always 

on.I/O module: P light is always on, R light is always on. 

9. Test I/O Modules 

1. Click the  button to log out. 

2. Double-click the coupler to switch to the "EtherNet/IP I/O Mapping" tab. 

3. Select "Enable 1" mode from the drop-down list in the lower right corner, as shown below. 
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4. Click  to monitor the data in the following screen. 
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7.6.2 Application In KV STUDIO Ver.10G Software Environment 

1. Preparations 

Hardware Environment 

A computer with pre-installed KV STUDIO Ver.10G software. 

Network cables. 

One switching power supply. 

Module mounting rails and rail fixings. 

Please configure the module model and type according to the actual configuration, such as the following 

table: 

Devices Model Number Quantities 

PLC KV-NC32 1 

Coupler XB6-EI2002ST 1 

I/O 
Module (in software) 

XB6-1600B 1 

XB6-3200A 1 

XB6-A80I 1 

XB6-0032B 1 

XB6-A80V 1 

XB6-A04I 1 

End Cover XB6-CVR00 1 

Device Configuration Files   

Configuration file access: https://www.solidotech.com/documents/configfile 

Hardware configuration and wiring 

Please follow the "5Installation and Disassembly " and "6Wir " require operation. 

2. Create Project 

1. Open KV STUDIO software, select "File -> New Project". 

2. In the popup box, fill in "Project Name", select "Supported Models", "Location". 

 

Item name: Customization 

Supported models: View PLC appearance and select the corresponding model, e.g. KV-8000 

https://www.solidotech.com/documents/configfile
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3. The Confirm Unit Configuration Settings dialog box pops up, click Yes. 

 

3. Communication settings 

Select the communication method, if the PLC and the host computer software are connected through a network 

cable, select "Ethernet", if connected through USB, select "USB". 

Procedure for "Ethernet" operation 

1.  Click thebutton on the menu bar to display "Communication Settings". 

 

2. Select Ethernet, configure the IP address, and click Find Connection Destination. 

The IP address is configured in the "192.168.0" network segment. 
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3. Select the NIC in the Find Connection Target pop-up box and click Perform Find. 

 

4. Check the found PLCs and click Select.  

5. Click OK. 

"USB connection" operation method 

Select USB on the "Communication Settings" screen. 
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4. Installation of EDS files 

1. Double click "EtherNet/IP" in the left navigation tree to enter the "EtherNet/IP Settings" interface, such as 

the following figure. 

 

2. Click "EDS File" in the menu bar of the "EtherNet/IP Settings" screen, and then click "Login". 

3. In the folder where the EDS file is located, select the EDS file of the corresponding model and click "OK". 

5. Topological configuration 

Topology configuration can be "manually added" and "automatic configuration" two ways, this configuration 

using manual configuration. 

1. Enter the "EtherNet/IP Settings" interface and switch to the "Device Search" tab as shown below. 

 

2. Click  to select the communication path. 

The USB connection is as follows:  
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The network cable is connected as follows: 

 

Select "Directly connect to PC's Ethernet port" and set the local NIC and IP address. 

3. Click  to find devices connected within the network. 

4. Set the IP address network segment for lookup. 

5. Click "Find" and the following example will be displayed when the search is completed. 

 

6. Double-click on a found device to add it to the configuration. 
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6. Setting the IP address 

In the interface of the found device, double-click the IP address column and configure the IP address in 

the pop-up box. The default address network segment is 192.168.0. 

Description: 

 The timeout for setting the IP address needs to be configured to 60s. 

 If the dipswitch has been configured with an IP address, the IP of the dipswitch takes precedence. 

7. parameterization 

The parameter setting function is used to configure the configuration of uplink data, downlink data, clear 

hold, configuration of module output action in bus RUN/IDLE state, input filtering, analog range, 

configuration, and temperature module parameter configuration.Table 7-2 Parameter Description See 

Table 72 for parameter descriptions. 

1. After adding a module, click Exclusive Owner to enter the Module Settings window. 

 

2. On the Connection Settings screen, click Parameter Settings to configure the module parameters in the 
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pop-up box. 

 

The "Parameter Settings" screen is shown below. 
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Table 7-2 Parameter Description 

Parameters Parameter Description 

Produce Data Size 

Uplink data, equal to 4+n*4+m*16 
n: number of digital input I/O modules (including hybrid I/O 
modules) 
m: Number of analog input I/O modules 
 

Consume Data Size 

Downstream data, equal to j*4 + k*16 
j: Number of digital output I/O modules (including hybrid I/O 
modules) 
k: Number of analog output I/O modules 

Hold or Clear Parameter 
The output is cleared or held: 
"0": clear, default is "0". 
"1": Maintain. 

IDLE Status Output Mode 
Module output action in bus RUN/IDLE state, configured as 
"0", clear, configured as "1", hold, default is "0". 

Digtal Input Filter Config Digital input filtering, default setting is "3 ms". 

Analog Input Filter Config Analog input filter, default setting is "10". 

Analog Voltage Input Range Select Analog input voltage module range, default setting is "0". 

Analog Electricity Input Range Select Analog input current module range, default setting is "0". 

Analog Voltage Output Range Select Analog output voltage module range, default setting is "0". 

Analog Electricity Output Range Select Analog output current module range, default setting is "0". 

Temperature IO Module Sensor Select 
Temperature module parameter that allows you to configure 
the type of sensor. 

Temperature IO Moduler Filter Config Temperature module filter configuration. 

IO Module  
Configured as the I/O in the actual configuration. 
Modify IO Module 1~ IO Module n to the corresponding 
configuration. 

3. Click Apply. 

4. Click OK. 

8. Configuration Download 

After the module configuration and parameter setting are completed, it is downloaded to the PLC. 

1. Select "Monitor/Simulator (N) -> PLC Transfer -> Monitor Mode (C)". 
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2. Click "Execute" to download to the PLC. 

9. Check the device indicator 

XB6-P2000H: P light is always on in green color.  

XB6-EI0002: P light is always on in green color, L light is always on, E light is not on, N light is always 

on.I/O module: P light is always on, R light is always on. 

10. data monitoring 

In monitoring mode, double click "XB6-EI0002" icon to open the monitoring table, you can monitor the 

corresponding module. The following figure is shown: 
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Correspondence table of soft components and modules: 

Soft Component Corresponding Modules 

W00~ W01 XB6-EI0002 

W02~W03 XB6-1600B 

W04~W0B XB6-A80I 

W0C~W013 XB6-A80V 

W014~W015 XB6-3200A 

W016~W017 XB6-0032B 

W018~W01F XB6-A04I 
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7.6.3 Application In CX-One Software Environment 

1. Preparations 

Hardware Environment 

 Module preparation 

This description uses the XB6-EI2002ST module kit, XB6-1600B, XB6-3200A, XB6-A80I, XB6-

0032B, XB6-A80V, and XB6-A04I six modules as an example. 

 One computer with CX-One software pre-installed 

 EtherNet/IP special shielded cable 

 One Omron PLC, this description takes KV-NC32 as an example 

 One switching power supply 

 Module installation guide rails and guide rail fixings 

 Device Configuration Files   

Configuration file access: https://www.solidotech.com/documents/configfile  

 Hardware configuration and wiring 

Please follow the "5Installation and Disassembly " and "6Wir " require operation. 

2. New construction 

1. Open CX-Programmer software and select "File -> New". 

 

2. The "Change PLC" window pops up, select "Device Type" and click "Set" to view the appearance of the 

PLC and select the actual device type. 

Example: 

 

3. The "Device Type Setting" window pops up to view the appearance of the PLC and select the actual 

device type, for example: 
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4. Click OK. 

5. In the "Change PLC" window, select "Network Type", i.e., the way the PLC connects to the computer, 

which is categorized into USB connection and network cable connection, and the corresponding network 

types are "USB" and "EtherNet/IP" respectively. The corresponding network types are "USB" and 

"EtherNet/IP". 

 The "USB" type is as follows: 

a) Select the network type as "USB" and click "Settings". 

 

b) In the "Network Settings" pop-up window, select "Direct Connection". 

c) Click OK. 

 The "EtherNet/IP" type is as follows: 

a) Select the network type as "EtherNet/IP" and click "Settings". 
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b) Enter the PLC address in the "Network Settings" pop-up window. 

 

Note: In "EtherNet/IP" mode, the IP of the computer needs to be set to the same network 

segment as the PLC. 

c) Click OK to complete the creation of the new project. 

3. Setting the PLC IP address 

1. Double-click "IO Table and Unit Settings" to open the "PLC IO Table" screen. 

2. Double-click to select the PLC module under "Built-in port/slice version", for example: 
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3. The IP address of the PLC can be reset (not configurable when using a USB connection). 

 

4. Click OK to complete the PLC IP address setting. 

4. Installation of EDS files 

1. Double-click "IO Table and Unit Settings" to open the "PLC IO Table" window. 

2. Right click on the built-in EIP module and select "Launch Dedicated Application -> Inherit Settings 

Launch" as shown below. 

 
3. The "Select Special Program" screen will pop up, select "Network Configurator" as shown below. 
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4. Click OK to enter the Network Configurator Settings screen as shown below. 

 

5. Click "EDS File -> Install" in the menu bar, select the "EDS file" to be installed, and complete the file 

installation. 
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5. Hardware Configuration 

Adding PLCs and couplers can be done manually or by automatic scanning. 

Manual addition method: 

1. In the left navigation bar of "Network Configurator", expand the "DeviceType" directory, and double-click 

the PLC and coupler to add them to the network, as shown in the following figure. 

 

2. Select the PLC icon and right click. 

3. Click "Change Node Address" and enter the destination IP address, for example: 

 

Click OK. 

4. Select the coupler icon and right click. 

5. Click "Change Node Address" to enter the destination IP address, please enter the actual address of the 

coupler, for example: 

 

Click OK. 

Automatic scanning method: 

1. Click the Connect icon as shown below. 
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2. The "Setup Interface" window pops up as shown below. 

 

3. Check "TCP:2". 

 

The following dialog box pops up. 

 

4. Click OK. 
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5. Click the following icon. 

 

6. The "Setup Interface" window pops up as shown below. 

 

If the coupler cannot be swept out, use the "Ethernet Device Configuration" tool to modify the IP address of the 

coupler, and then reopen the operation. 

6. Parameter setting and I/O module addition 

The parameter setting function is used to configure the configuration of uplink data, downlink data, clear hold, 

input filter, analog range, configuration, and temperature module parameters.Table 7-3 Parameter Description 

Parameter Description 

1. Double-click the coupler icon to enter the "Edit Device Parameters" window to set the parameters. 

2. Set the "Produce Data Size" (upstream data) and "Consume Data Size" (downstream data) according to 

the actual settings , such as the following figure: 
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Table 7-3 Parameter Description 

parameters Parameter description 

Produce Data Size 

Uplink data, equal to 4+n*4+m*16 
n: number of digital input I/O modules (including hybrid I/O 
modules) 
m: Number of analog input I/O modules 

Consume Data Size 

Downstream data, equal to j*4 + k*16 
j: number of digital output I/O modules (including hybrid I/O 
modules) 
k: Number of analog output I/O modules 

Hold or Clear Parameter 
The output is cleared or held: 
0: Clear, default is "0". 
1: Hold. 

IDLE Status Output Mode 
Module output action in bus RUN/IDLE state, configured as 
"0", clear, configured as "1", hold, default is "0". 

Digtal Input Filter Config Digital input filtering, default setting is "3 ms". 

Analog Input Filter Config Analog input filter, default setting is "10". 

Analog Voltage Input Range Select Analog input voltage module range, default setting is "0". 

Analog Electricity Input Range Select Analog input current module range, default setting is "0". 

Analog Voltage Output Range Select Analog output voltage module range, default setting is "0". 

Analog Electricity Output Range Select Analog output current module range, default setting is "0". 

Temperature IO Module Sensor Select 
Temperature module parameter that allows you to configure 
the type of sensor. 

Temperature IO Moduler Filter Config Temperature module filter configuration. 

IO Module n 
Configured as the I/O in the actual configuration. 
Modify IO Module 1~ IO Module 3 to the corresponding 
configuration. 

 

7. Setting label variables 

1. Double-click the PLC icon to open the "Edit Device Parameters" window, such as the one shown below. 
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2. Select the device, click the  button, and double-click the device to display the following interface. 

 
3. Click the following button. 
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4. The "Edit Tag Set" window pops up. 

5. First click the "Edit Tags" button, then click the "New" button, as shown below. 

 

6. The "Edit Tag" window pops up, and you can set the upper row data. 
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Name: the starting ID of the uplink data, representing the starting ID of the input module in the 

configuration. 

Size: upstream data, see value6Parameter setting and I/O module addition See 6 Parameter Settings 

and I/O Module Additions for values. 

7. Click "Regist". 

8. Click "Close". 

9. Click OK. 

10. Click OK to save the configuration. 

11. Click the following button. 

 

12. The same method is used to set up the downstream data, for example in the following figure. 
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Name: Starting ID of the downstream data, starting ID of the output module in the configuration. 

Size: downstream data. 

The starting ID value of the downlink data needs to be greater than the starting ID of the uplink data + 

the uplink data. 

13. Select upstream data and downstream data in "Connection Type", such as the following figure. 

 

14. Click "Regist". 

15. Click "Close". 

16. Click OK. 

8. PLC Download 

1. (When "Auto Scan" is selected for the configuration, this step is omitted and executed directly.3 Connect 

to the network. 

"USB" type 

a) Click the menu "Option" button and select the network type "SJ2 USB/serial port". 



XB6 Series EtherNet/IP Slice I/O User Manual                                                           7 Operation 

 

111                                Copyright © Nanjing Solidot Electronic Technology Co. 

 

b) Click the Connect icon as shown below. 

 

c) The "Setup Interface" window pops up as shown below. 

 

d) Expand the collapsed buttons in turn and select "TCP:2". 
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e) Click "OK" and the following window will pop up. 

 

"EtherNet/IP" type 

a) Click on the menu "Option" button and select the network type "Ethernet I/F". 

b) Click the Connect icon as shown below. 

 

c) The "Setup Interface" window pops up as shown below. 
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d) Check "TCP:2". 

 

The following dialog box pops up. 

 

2. (This step is omitted when the configuration selects the automatic scanning method.) Click OK. 

3. Select the PLC icon and click the "Download to Device" icon as shown below. 
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4. Click Yes in the Network Configurator pop-up window. 

5. Select the module and click the following button. 

 

6. The following window will pop up, indicating that the download is complete, click "OK". 

 

Note: If the PLC reports a connection error after the download is complete, please check the parameter 

configuration and re-download after power failure and reboot (download NetWork Configurator first, then 

CX-Programmer). 

9. Check the device indicator 

XB6-P2000H: P light is always on in green color.  
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XB6-EI0002: P light is always on in green color, L light is always on, E light is not on, N light is always 

on.I/O module: P light is always on, R light is always on. 

10. IO table and unit setup verification 

1. Switch to the CX-Programmer programming software as shown below. 

 

2.  Click the  icon and the following screen appears below. 

 

3. Double-click the address area to bring up the Edit Dialog. 

4. In the "Address and Name" field, write the channel address. For example, if the downstream data name 

is set to "D700", the starting address of the output module in the configuration is "D700". 

 

Click OK to monitor the corresponding values. 


